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Introduction
This document provides details on using the "RM Device Finder" application software (version 3.0.0 or
later), compatible with all RM series devices.

What is "RM Device Finder"?
"RM Device Finder" is an application that detects RM series devices on the network and opens the
device’s Web GUI "Device Manager" in a web browser. It can also be used to review the setup of the
Divide/Combine Room feature (preset settings to divide/combine multiple rooms) and the preset
switching as well as to specify settings for CTL-BN1 (controller).

Conventions Used in This Guide

Trademarks
• Dante is a registered trademark of Audinate.
• Windows is a registered trademark of Microsoft Corporation in the United States and other

countries.
• Other company names and product names mentioned in this document are trademarks or registered

trademarks of their respective corporate owners.

Content
• All copyrights relating to this software and User Guide are owned by Yamaha Corporation.
• This software and User Guide must not be modified in whole or in part without permission.
• We assume no responsibility whatsoever for any consequences or subsequent impacts resulting from

the use of this software or User Guide.
• For the purpose of improvement, this software and User Guide are subject to change without prior

notice.
• This software is not guaranteed to work with a Windows touchscreen.
• The illustrations and screens in this User Guide are for instructional purposes only.
• The operation and screen examples provided in this User Guide are based on Windows 10.

Software Operating Environment
This software runs on Windows.

OS Windows 10, Windows 11

Must be able to run .NET Framework 4.5.2 or later

NOTE

Some computers may have requirements that exceed the recommended environment.
Refer to the Yamaha website for up-to-date information on the latest software versions
and operating requirements.

Yamaha website:
https://download.yamaha.com
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Target Models
In order to take full advantage of the features of "RM Device Finder" version 2.0.0.0 or later, the
firmware version of your device must meet the following requirements. Use RM Device Finder to
update the device firmware to the latest version.

Model Version

RM-CR 1.0.1 or later

RM-CG 1.0.1 or later

RM-TT 1.1.0 or later

RM-WAP16 1.8.3 or later

RM-WAP8 1.8.0 or later

VXL1-16P 1.1.0 or later

VXC2P 2.8.0 or later

CTL-BN1 2.8.0 or later

NOTE

• In order to use the Divide/Combine Room feature, firmware compatible with ADECIA
version 2.0.0 or later is required.

• In order to update the VXL1-16P Dante module, firmware compatible with ADECIA
version 2.5.0 or later is required.

• In order to assign functions to CTL-BN1, firmware compatible with ADECIA version 2.8.0
or later is required.
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Connection Diagram and Features
This section shows an example of how to connect devices and describes the features supported by "RM
Device Finder".

NOTE

Connection ① is required if the following conditions are met at the same time.

• [ETHERNET SWITCH SETTINGS] in the Web GUI "RM-CR Device Manager" is set to
[Separated].

• RM-CR’s [Dante] and [Corporate] ports are set to the same IP segment.

Function RM-CR
RM-CG
RM-TT

RM-WAP RM-WCH RM-WOM
*1

VXC2P
VXL1-16P

CTL-BN1

Device detection ✓ ✓ — — ✓ ✓

Web GUI startup ✓ ✓ — — — —

Firmware update ✓ ✓ *2 *2 ✓ ✓

Divide/Combine Room
feature setup

✓ ✓ *3 *3 ✓ ✓

Preset switching review ✓ ✓ *3 *3 ✓ ✓

CTL-BN1 function
assignment

— — — — — ✓

*1: Four models: RM-WOM, RM-WDR, RM-WGL, RM-WGS
*2: Perform from the Web GUI "RM-WAP Device Manager", started from "RM Device Finder"
*3: In accordance with the RM-WAP settings
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RM Device Finder User Guide | 5



Computer Network Settings
By default, the RM series network is automatically configured with DHCP. If there is no DHCP server in
the network, the IP address is automatically specified in Auto IP mode.
If you want to manually configure the network or set the RM series network to connect to and coexist
with an existing network, specify the settings to match the LAN to be connected to. Consult with your
LAN administrator for details.

Computer TCP/IP Settings
Specify your computer’s TCP/IP settings if you want to manually configure the network or set the RM
series network to connect to and coexist with an existing network. Follow the steps below to adjust
the settings.

1. Open the "Control Panel", and then click [Network and Sharing Center] or [View network
status and tasks].

"Network and Sharing Center" appears.

2. In "Network and Sharing Center", click [Change adapter settings], and then double-click [Local
Area Connection].

The "Local Area Connection Status" dialog box appears.
If the "Local Area Connection Properties" dialog box appears, go to step 4.

3. Click [Properties].

The "Local Area Connection Properties" dialog box appears.

4. Select [Internet Protocol Version 4 (TCP/IPv4)], and then click [Properties].

The "Internet Protocol Version 4 (TCP/IPv4) Properties" dialog box appears.

5. Select [Use the following IP address (S)].
6. Type the IP address of your computer beside [IP address], the subnet mask for the subnet to be

connected to beside [Subnet mask], and the IP address of the gateway beside [Default
gateway].

If you want to set the RM series network to coexist with an existing network, ask your LAN
administrator for details.

7. Click [OK].
8. Restart your computer.
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Installing and Starting "RM Device Finder"

Installing "RM Device Finder"
Download and install the "RM Device Finder" installation file to your PC.

1. Download the latest version of the installation software from the Yamaha website.

Yamaha website:
https://download.yamaha.com

2. Extract the compressed file and install the application software.

❶ Extract the zip file and open it in the desired location.
❷ Double click the file "RMDeviceFinderInstaller.exe" in the folder.
❸ Install the application by following the instructions in the Installer.

Starting "RM Device Finder"
Start "RM Device Finder" using one of the methods below.

• Double click the "RM Device Finder" shortcut icon
(if you checked the [Create a desktop shortcut] option on the Install screen)

• Select the program from your Windows Start icon

The "Select Network Interface Card" screen appears when "RM Device Finder" is started.

Installing and Starting "RM Device Finder"
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"RM Device Finder" Screen

"Select Network Interface Card" Screen
This screen allows you to select a network interface card. It appears when "RM Device Finder" is
started. From the list, select one of the network interface cards in the RM series, and then click the
[OK] button.

Click the [OK] button to display the "RM Device Finder" main screen.

NOTE

You can also display the "Select Network Interface Card" screen by clicking the [Network]
button (❻) in the "RM Device Finder" main screen.

"RM Device Finder" Screen
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"RM Device Finder" Main Screen

❶ [File] menu
[Firmware Update]

Displays the "Firmware Update" screen (for updating device firmware).
For details, refer to "Firmware Update" screen.
You can also display the "Firmware Update" screen using the following method:

• Click the [Firmware Update] button (❼).
[Exit]

Closes the application.
You can also close the application using the following methods:

• Click the [×] button in the corner of the screen.
• Click the [Close] button (➓).

❷ [Search Options] menu
[Search by IP address]

Uses TCP to detect a device with a specified IP address.
For details, refer to "Device search by IP address" screen.

[Search by file]
Imports a list of detected devices from a CSV file.

[Save device file]
Exports the list of detected devices to a CSV file.

❷ [Tools] menu
[Preset Recall]

Displays the "Preset Recall" screen (for recalling presets).

[Divide/Combine Room Wizard]
Displays the "Divide/Combine Room Wizard" screen (for specifying divide/combine settings for
multiple rooms).
For details on [Preset Recall] and [Divide/Combine Room Wizard], refer to Using the
Divide/Combine Room Feature.

"RM Device Finder" Screen
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[CTL-BN1 Configuration Settings]
Displays the "CTL-BN1 Configuration Settings" screen (for assigning functions to CTL-BN1).

❸ [Help] menu
[About]

Displays the application name and version number.

[Legal]
Displays the license information for the open-source software used in this application.

❹ "Detected Devices" list

Lists information on detected devices.
Select a device with the  [Web UI] icon, and then click the [Browse] button to open the device’s
Web GUI "Device Manager" in a web browser. You can also open the device’s Web GUI "Device
Manager" by double-clicking the row of a device with the  [Web UI] icon.

NOTE

• The web browser used to open the device’s Web GUI "Device Manager" depends on your
computer’s settings.

• No [Web UI] icon appears if the model does not have a Web GUI "Device Manager".
• Only RM series devices with network support are displayed.

❺ [Refresh] button

Clears the list and detects devices again.
If no valid network interface card is selected, the [Refresh] button is grayed out and cannot be
clicked.
(After it has been clicked, the button cannot be clicked again for 5 seconds.)

❻ [Network] button

Displays the "Select Network Interface Card" screen (for selecting a network interface card).
The "Select Network Interface Card" screen also appears when the application is started.
For details, refer to "Select Network Interface Card" screen.

❼ [Firmware Update] button

Displays the "Firmware Update" screen (for updating device firmware).
For details, refer to "Firmware Update" screen.

❽ [Identify] button
Causes the indicator of the device selected in the list to flash for 5 seconds. Used to identify
equipment.

❾ [Browse] button
Opens (in a web browser) the Web GUI "Device Manager" for the device selected in the list.

❿ [Close] button

Closes the application.
You can also close the application using the following methods:

• Click [File] (❶), then [Exit].
• Click the [×] button in the corner of the screen.

"RM Device Finder" Screen
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"Device search by IP address" Screen
Using TCP, a device with the specified IP address can be detected. This allows you to search for
multiple devices on different networks as well as update the firmware for devices in remote locations.
In order to use this function, display the "Device search by IP address" screen by using the provided
menu path.

[Search Options] → [Search by IP address]

There are two ways to specify an IP address.
* Search by IP range
* Search by IP address

Search by IP range
You can specify a range by entering an IP address and subnet mask.

Search by IP address
You can specify multiple IP addresses by separating them with commas or line breaks, or you can
specify a range of IP addresses by connecting them with a hyphen.

"RM Device Finder" Screen
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Clicking the [Start] button in the screen shown above displays the following screen and starts the
device search.

You must log in to any device where a [Login…] button appears.
Click the [Login…] button, and then type the password in the screen that appears (shown below).

When the search is finished, click the [Close] button to close the "Device search by IP address" screen
and update the "Detected Devices" list in the "RM Device Finder" main screen.

"RM Device Finder" Screen
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"Firmware Update" Screen

This screen allows you to update the firmware of detected devices.
It can be displayed by clicking the [Firmware Update] button in the "RM Device Finder" main screen or
by using the menu path below.

[File] → [Firmware Update]

❶ "Path"
Displays the path of the selected firmware file.

❷ […] button
Allows you to select a firmware file.

❸ "File Info" list
Lists models compatible with the selected firmware file and their version numbers.

❹ "Select Devices to Update" list
Lists devices and the progress of their firmware updates.

Status Progress

Updating… "Updating…" flashes in the screen while the firmware file is being transferred.
The progress of the update is indicated by a progress bar.

Success Indicates that the firmware file transfer is finished and the update was
successful.

Failed Indicates that the firmware file transfer is finished, but the update failed.

"RM Device Finder" Screen
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Status Progress

Skip Indicates that the device did not respond to the firmware update command, or
that the firmware file transfer is finished, but the update was skipped for some
reason.

Error Indicates that an error occurred while transferring the file or that the device did
not respond after the file was sent.

❺ [Refresh] button
Clears the "Select Devices to Update" list and detects devices again.

❻ [Network] button
Displays the "Select Network Interface Card" screen so that a network interface card can be
selected.

❼ [Update] button
Starts the firmware update.

❽ [Identify] button
Causes the indicator of the device selected in the list to flash for 5 seconds. Used to identify
equipment.

❾ [Browse] button
Opens (in a web browser) the Web GUI "Device Manager" for the device selected in the list.

❿ [Close] button
Closes the "Firmware Update" screen.

NOTE

• No buttons can be clicked while firmware is being updated.
• Firmware for RM-WCH-8, RM-WDR, RM-WOM, RM-WGS, and RM-WGL cannot be updated

by using "RM Device Finder". Update these devices by using Web GUI "RM-CR Device
Manager".

• For details, refer to the Reference Manual for the RM Series Wireless Microphone.

"RM Device Finder" Screen
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Updating the Firmware
You can update the device’s firmware from the "Firmware Update" screen.

Follow the steps below to update the firmware:

1. Select the firmware file from the file selection screen that appears when you click the […]
button.
The firmware file can be downloaded from the Yamaha website.

Yamaha website:
https://download.yamaha.com

2. In the "Model" column of the "Select Devices to Update" list, check the boxes next to the
devices you want to update.

3. Then click the [Update] button.
4. Follow the on-screen instructions to perform the firmware update.

A dialog box confirming completion will appear when the update is complete.

Updating the Firmware
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Using the Divide/Combine Room Feature
If you want to variably partition a room or share ADECIA devices or audio signals in multiple rooms, the
"RM Device Finder" Divide / Combine Room feature allows you to switch between the divide/combine
configurations and the presets required to verify that the features are working in the room.

Follow the following steps to use the Divide/Combine Room feature.

1. In [Tools], go to [Divide / Combine Room Wizard] to change room division/combination settings, and
set used devices and presets.

2. In [Tools], go to [Preset Recall] to recall the presets set in 1.

"Divide / Combine Room Wizard"
Follow the instructions displayed on the Wizard Screen to make settings.

"Introduction" Screen
This is a feature description screen for the "Divide / Combine Room Wizard". It explains the following:

• These settings can be used to divide or merge up to four adjacent rooms.
• Presets can be saved using this feature to match the settings of rooms and used devices to usage

scenarios.
• This Wizard allows you to configure rooms, group devices on the network around RM-CR, and then

create multiple presets with different device configurations.

Click the [Nex] button to continue to the next screen. Click the [Close] button to close the Wizard
Screen.

Using the Divide/Combine Room Feature
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"Room Design" Screen
Drag the cell to create a "Room". You can create up to four "Rooms".

Click the [Reset] button to delete all of the "Rooms" you have created.
Click the [Next] button to continue to the next screen.
Click the [Close] button to close the Wizard Screen. You can also save the all the settings you have
configured in the Wizard up to this point.

NOTE

• Click the "Room" you created again to delete it.
• Dragging the "Room" lets you expand it.

Using the Divide/Combine Room Feature
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"Assign Devices to the rooms" Screen
Any RM-CRs and peripheral devices (such as microphones and speakers) detected on the network will
be displayed in a list. You can designate the "Rooms" in which each device can be used.

Click the  Edit button to change the Hostname of the selected device.
Click the  LED Indicator button to cause the LED of the selected device to blink.
Click the [Reset] button to clear the numbers of all designated "Rooms".
Click the [Next] button to continue to the next screen.
Click the [Back] button to return to the previous screen.

NOTE

One room can contain up to one RM-CR, 16 microphones, and 15 speakers. Also, make sure
that the total number of microphones and speakers in a room is no more than 16.

Using the Divide/Combine Room Feature
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"Create room layouts" Screen
Use the partitioning buttons in the spaces between rooms to register all of the ways you anticipate a
room will be used. This will allow you to register various partitioned and merged patterns as "Layouts".

Click the [Add Layout] button to register a "Layout".
Click the [Remove] button to delete a registered "Layout".
Click the [Reset] button to delete all registered "Layouts".
Click the [Next] button to continue to the next screen.
Click the [Back] button to return to the previous screen.

NOTE

• Up to 10 "Layouts" may be registered.
• Rooms that have the same color will be used as a single room.

Using the Divide/Combine Room Feature
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"Select the Devices for each combined rooms" Screen
Here, you can set the devices that will be used in each room for the "Layouts" you have created.

❶ Select a "room combination".
❷ Select RM-CR.
❸ Determine configurations for the peripheral devices.

Click the [Remove] button to delete a device from a "room combination".
Click the [Reset] button to clear all of the set "room combinations".
Click the [Next] button to continue to the next screen.
Click the [Back] button to return to the previous screen.

NOTE

If a "room combination" is displayed in red text, this means that you have exceeded the
maximum usable "room combinations", and you will need to make adjustments

Using the Divide/Combine Room Feature
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"Assign the speaker locations for each room combination" Screen
On this screen you can select a "room combination" and set the source type (L/R) for a Dante speaker.

❶ Select a "room combination".
❷ Set the "Position" of the speaker.

Click the [Reset] button to clear all source type (L/R) settings for the speakers.
Click the [Next] button to continue to the next screen.
Click the [Back] button to return to the previous screen.

Using the Divide/Combine Room Feature
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"Create presets" Screen
Set a preset name for "Layouts" for each room.

Click the [Reset] button to clear all the "Preset Names" that you entered.
Click the [Next] button to continue to the next screen.
Click the [Back] button to return to the previous screen.

NOTE
Register a "Layout" as a preset for all networked RM-CRs

Using the Divide/Combine Room Feature
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"Install Presets" Screen
Click the [Execute] button to register your created Presets with all RM-CRs on the network. You will
need a login password for the "RM-CR Device Manager" to register presets.

Click the [Back] button to return to the previous screen.

Using the Divide/Combine Room Feature
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Completion Screen
You have completed your configuration.
Click the [Close] button to close the Wizard.
You can switch between registered settings on the "Preset Recall" screen.

NOTE

If necessary, adjust sound quality and override presets by going to "Preset Recall" screen to
make adjustments and conduct overrides while device configurations are reflected for each
room. Use the "Device Manager" web GUI to adjust sound quality and override presets.

Using the Divide/Combine Room Feature
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"Preset Recall" Screen
You can recall presets for multiple selected RM-CRs at the same time."Divide / Combine Room Wizard"
presets are switched on this screen.

❶ "RM-CR" Device List
Displays a list of the RM-CRs detected on the network. Select the device for which you want to
recall the preset.

❷ [Select all RM-CRs]
Sets all RM-CRs listed in the "RM-CR" Device List as targets for preset recall.

❸ [Select a Preset Number]
Select the number of the preset you want to recall.

❹ [Execute]
Recalls the preset numbers in ❸ for all RM-CRs selected in ❶.

❺ [Close]
Close the "Preset Recall" screen.

Using the Divide/Combine Room Feature
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Assigning Functions to CTL-BN1
Any one of the following functions can be assigned to the CTL-BN1 button.

Function Description

Mic Mute All Mutes all microphones.

Mic Mute Group Mutes grouped microphones.

Mic Mute Individual Mutes a single microphone.

Mic Mute Force All Individual Mutes microphones not grouped.

Speaker Mute Mutes the speaker.

Control Sets / Multiple Sends Control Sets (commands) registered with CTL-BN1. (Up to 4
sets)

Control Sets / Single Sends Control Sets (commands) registered with CTL-BN1.

Preset Recall / Multiple Recalls presets registered with RM-CR. (Up to 4 presets)

Preset Recall / Single Recalls presets registered with RM-CR.

Divide / Combine Room Switches device settings according to specified room
divisions/combinations.

In order to assign functions to CTL-BN1, display the "CTL-BN1 Configuration Settings" screen.

[Tools] → [CTL-BN1 Configuration Settings]

NOTE

• The "CTL-BN1 Configuration Settings" screen is a settings tool for using CTL-BN1
independently of RM-CR.
When using CTL-BN1 as a peripheral of RM-CR, use the settings under "Peripheral Detail
/ CTL-BN1" in the Web GUI "RM-CR Device Manager".

• For details on CTL-BN1, refer to the CTL-BN1 Reference Manual.

Assigning Functions to CTL-BN1
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"CTL-BN1 Configuration Settings" Screen
This explains how to use the "CTL-BN1 Configuration Settings" screen.

Displaying the CTL-BN1 Function Assignment Dialog Box ([Home] Tab)
Follow the steps below to display the CTL-BN1 function assignment dialog box.

❶ Select the CTL-BN1 to be set.
❷ Click the [Home] tab.
❸ Click .

The CTL-BN1 function assignment dialog box appears.

Assigning Functions to CTL-BN1
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Selecting a Function To Be Assigned

"Function" list

Select the function to be assigned.
The settings for the selected function appear.

"Device" list
Lists devices that can be used with the selected function.

"Position" list
Each of the four LED ring sections has a position number. This appears when the "Control Sets /
Multiple", "Preset Recall / Multiple" or "Divide/Combine Room" feature was selected, and it allows
the function to have four events.
Click the image to rotate it 180°. Select the orientation that corresponds to the installation of
CTL-BN1.

1 2 3 4

"Parameter" list
Lists settings related to the additional parameter for the selected function, for example, the
microphone number, microphone mute group number, preset number.

"Button Behavior"
Select how muting is to be performed.

• [Toggle]: Pressing the button switches between muting/unmuting.
• [Push To Talk]: Unmutes while the button is pressed.
• [Push To Mute]: Mutes while the button is pressed.

"LED Indication"
Select the indicator color and lighting pattern.

• [Color]: Select the color for each button status.
• [Pattern]: Select the lighting pattern for each button status.

([Off], [Lit], [Slow Flash] or [2 Times Flash])

Assigning Functions to CTL-BN1
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Details of the Functions That Can Be Assigned
Mic Mute All

This function mutes all microphones on the selected device.

Mic Mute Group

This function mutes the grouped microphones.
Under "Parameter", select the group number for the microphones to be muted.

Mic Mute Individual

This function mutes a single microphone.
Under "Parameter", select the number that identifies the microphone. If an RM-CR was selected
under "Device", select the Dante input channel. If an RM-WAP was selected under "Device", select
the microphone number.
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Mic Mute Force All Individual
This function mutes all microphones that are not grouped.

Speaker Mute
This function mutes the speaker.
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Control Sets / Multiple

This function sends Control Sets (commands) registered with CTL-BN1.
Under "Position", select the position number for one of the four LED ring sections, and then register
the Control Set. Settings can be specified for each of the four position numbers.

With "Event Mode", separate On and Off Control Sets can be registered.
Be sure to check this setting before registering a Control Set.

• Single Command Sequence: The same Control Set is sent each time
the button is pressed.

• Toggle(On/Off): Each press of the button alternately sends the On
Control Set or the Off Control Set.

Up to five commands can be specified in each Control Set. Specify the following information for
each command.

"Protocol" Transmission protocol ([UDP] or [TCP])

"IP Address" IP address of the device

"Port No." Port number for the device

"Delay" Delay time between pressing the button and sending the command

"Connection Delay" Delay time between sending the command and disconnecting

"Comments" Comments

"Command" Commands ([Hex] or [ASCII]), up to 256 bytes
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Control Sets / Single

This function sends Control Sets (commands) registered with CTL-BN1.
Compared to “Control Sets / Multiple”, only one Control Set can be registered, but the step of
selecting the Control Set can be omitted.

With "Event Mode", separate On and Off Control Sets can be registered.
Be sure to check this setting before registering a Control Set.

• Single Command Sequence: The same Control Set is sent each time
the button is pressed.

• Toggle(On/Off): Each press of the button alternately sends the On
Control Set or the Off Control Set.

Up to five commands can be specified in each Control Set. Specify the following information for
each command.

"Protocol" Transmission protocol ([UDP] or [TCP])

"IP Address" IP address of the device

"Port No." Port number for the device

"Delay" Delay time between pressing the button and sending the command

"Connection Delay" Delay time between sending the command and disconnecting

"Comments" Comments

"Command" Commands ([Hex] or [ASCII]), up to 256 bytes
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Preset Recall / Multiple

This function recalls presets registered with RM-CR.
Under "Position", select the position number for one of the four LED ring sections. Then, under
"Parameter", select the preset number. Settings can be specified for each of the four position
numbers.

Preset Recall / Single

This function recalls presets registered with RM-CR.
Compared to “Preset Recall / Multiple”, only one preset can be registered, but the step of selecting
the preset can be omitted.
Under "Parameter", select the preset number.

Divide / Combine Room
This function switches device settings according to specified room divisions/combinations. This is
the same as "Preset Recall", explained in "Using the Divide/Combine Room Feature".
Under "Device", select the RM-CR for each room to be configured. Under "Position", select the
position number for one of the four LED ring sections. Then, under "Parameter", select the preset
number. Settings can be specified for each of the four position numbers.
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CTL-BN1 Basic Settings Tab ([Device] Tab)
Follow the steps below to display the CTL-BN1 basic settings tab.

❶ Select the CTL-BN1 to be set.
❷ Click the [Device] tab.

"IP Address Setting"

Specifies the IP address. Select whether to use DHCP or assign a static IP address.
To assign a static IP address, specify settings for the following.
"IP Address"
"Subnet Mask"
"Default Gateway"

"Hostname Settings"
Specifies the hostname for CTL-BN1.

"Mode" [Yamaha Hostname using Unit ID]: The hostname is automatically generated from the
unit ID, model name and MAC address.
[Manual]: Specify manually.

"Unit ID" Select the unit ID. If [Manual] was selected, this is not available.

"Hostname" Type in the hostname. If [Yamaha Hostname using Unit ID] was selected, the
hostname that was generated is displayed.

"Brightness"
Select the brightness of the indicators.

"Idle Status"
Specifies the settings for the idle state indicators.

"Color" Select the color.

"Pattern" Select the lighting pattern.
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